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conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 
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Preface  

This users guide provides documentation and examples on how to use the OpenModelica system, both 
for the Modelica beginners and advanced users. 
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Chapter 1  
 
Introduction 

The OpenModelica system described in this document has both short-term and long-term goals: 

• The short-term goal is to develop an efficient interactive computational environment for the Modelica 
language, as well as a partial but rather complete implementation of the language. It turns out that with 
support of appropriate tools and libraries, Modelica is very well suited as a computational language for 
development and execution of both low level and high level numerical algorithms, e.g. for control system 
design, solving nonlinear equation systems, or to develop optimization algorithms that are applied to complex 
applications. 

• The longer-term goal is to have a complete reference implementation of the Modelica language, including 
simulation of equation based models and additional facilities in the programming environment, as well as 
convenient facilities for research and experimentation in language design or other research activities. 
However, our goal is not to reach the level of performance and quality provided by current commercial 
Modelica environments that can handle large models requiring advanced analysis and optimization by the 
Modelica compiler. 

The long-term research related goals and issues of the OpenModelica open source implementation of a Modelica 
environment include but are not limited to the following: 

• Development of a complete formal specification of Modelica, including both static and dynamic semantics. 
Such a specification can be used to assist current and future Modelica implementers by providing a semantic 
reference, as a kind of reference implementation. 

• Language design, e.g. to further extend the scope of the language, e.g. for use in diagnosis, structural analysis, 
system identification, etc., as well as modeling problems that require extensions such as partial differential 
equations, enlarged scope for discrete modeling and simulation, etc. 

• Language design to improve abstract properties such as expressiveness, orthogonality, declarativity, reuse, 
configurability, architectural properties, etc. 

• Improved implementation techniques, e.g. to enhance the performance of compiled Modelica code by 
generating code for parallel hardware. 

• Improved debugging support for equation based languages such as Modelica, to make them even easier to use. 
• Easy-to-use specialized high-level (graphical) user interfaces for certain application domains. 
• Visualization and animation techniques for interpretation and presentation of results. 
• Application usage and model library development by researchers in various application areas. 

The OpenModelica environment provides a test bench for language design ideas that, if successful, can be submitted 
to the Modelica Association for consideration regarding possible inclusion in the official Modelica standard. 

The current version of the OpenModelica environment allows most of the expression, algorithm, and function 
parts of Modelica to be executed interactively, as well as equation models and Modelica functions to be compiled into 
efficient C code. The generated C code is combined with a library of utility functions, a run-time library, and a 
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numerical DAE solver. An external function library interfacing a LAPACK subset and other basic algorithms is under 
development. 

1.1 System Overview 
The OpenModelica environment consists of several interconnected subsystems, as depicted in Figure 1-1 below. 
 

Modelica 
Compiler 

Interactive 
session handler

Execution 

Graphical Model 
Editor/Browser 

Textual  
Model Editor 

   

Modelica 
Debugger 

Emacs  
Editor/Browser 

OMNotebook 
DrModelica 

Model Editor

Eclipse Plugin  
Editor/Browser 

 
Figure 1-1.  The architecture of the OpenModelica environment. Arrows denote data and control flow. The interactive 
session handler receives commands and shows results from evaluating commands and expressions that are translated 
and executed. Several subsystems provide different forms of browsing and textual editing of Modelica code. The 
debugger currently provides debugging of an extended algorithmic subset of Modelica. The graphical model editor is 
not really part of OpenModelica but integrated into the system and available from MathCore without cost for academic 
usage. 

The following subsystems are currently integrated in the OpenModelica environment: 

• An interactive session handler, that parses and interprets commands and Modelica expressions for evaluation, 
simulation, plotting, etc. The session handler also contains simple history facilities, and completion of file 
names and certain identifiers in commands.  

• A Modelica compiler subsystem, translating Modelica to C code, with a symbol table containing definitions of 
classes, functions, and variables. Such definitions can be predefined, user-defined, or obtained from libraries. 
The compiler also includes a Modelica interpreter for interactive usage and constant expression evaluation. 
The subsystem also includes facilities for building simulation executables linked with selected numerical ODE 
or DAE solvers. 

• An execution and run-time module. This module currently executes compiled binary code from translated 
expressions and functions, as well as simulation code from equation based models, linked with numerical 
solvers. In the near future event handling facilities will be included for the discrete and hybrid parts of the 
Modelica language. 

• Emacs textual model editor/browser. In principle any text editor could be used. We have so far primarily 
employed Gnu Emacs, which has the advantage of being programmable for future extensions. A Gnu Emacs 
mode for Modelica has previously been developed. The Emacs mode hides Modelica graphical annotations 
during editing, which otherwise clutters the code and makes it hard to read. A speedbar browser menu allows 
to browse a Modelica file hierarchy, and among the class and type definitions in those files. 
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• Eclipse plugin editor/browser. The Eclipse plugin provides file and class hierarchy browsing and text editing 
capabilities, rather analogous to previously described Emacs editor/browser. Some syntax highlighting 
facilities are also included. The Eclipse framework has the advantage of making it easier to add future 
extensions such as refactoring and cross referencing support. 

• OMNotebook DrModelica model editor. This subsystem provides a lightweight notebook editor, compared to 
the more advanced Mathematica notebooks available in MathModelica. This basic functionality still allows 
essentially the whole DrModelica tutorial to be handled. Hierarchical text documents with chapters and 
sections can be represented and edited, including basic formatting. Cells can contain ordinary text or Modelica 
models and expressions, which can be evaluated and simulated. However, no mathematical typesetting or 
graphic plotting facilities are yet available in the cells of this notebook editor. 

• Graphical model editor/browser. This is a graphical connection editor, for component based model design by 
connecting instances of Modelica classes, and browsing Modelica model libraries for reading and picking 
component models. The graphical model editor is not really part of OpenModelica but integrated into the 
system and provided by MathCore without cost for academic usage. The graphical model editor also includes 
a textual editor for editing model class definitions, and a window for interactive Modelica command 
evaluation. 

• Modelica debugger. The current implementation of debugger provides debugging for an extended algorithmic 
subset of Modelica, excluding equation-based models and some other features, but including some meta-
programming and model transformation extensions to Modelica. This is conventional full-feature debugger, 
using Emacs for displaying the source code during stepping, setting breakpoints, etc. Various back-trace and 
inspection commands are available. The debugger also includes a data-view browser for browsing hierarchical 
data such as tree- or list structures in extended Modelica. 

1.1.1 Implementation Status 

In the current OpenModelica implementation version 1.3 (October 2005), not all subsystems are yet integrated as well 
as is indicated in Figure 1-1. Currently there are two versions of the Modelica compiler, one which supports most of 
standard Modelica including simulation, and is connected to the interactive session handler, the notebook editor, and 
the graphic model editor, and another meta-programming Modelica compiler version which is integrated with the 
debugger and Emacs, supports meta-programming Modelica extensions, but does not allow equation-based modeling 
and simulation. Those two versions are currently being merged into a single Modelica compiler version. 

1.2 Interactive Session with Examples 
The following is an interactive session using the interactive session handler in the OpenModelica environment. (Also 
called WinMosh.exe (under Windows) or  mosh (under Linux) – the Modelica Shell).  

The Windows version which at installation is made available in the start menu as OpenModelica->OpenModelica 
Shell responds with an interaction window: 
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We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored in the 
variable x. The value of the expression is returned. 
>> x := 1:12 
 {1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12} 

Load the function bubblesort, either by using the pull-down menu File->Load Model, or by explicitly giving the 
command: 
>> loadFile("C:/OpenModelica13/testmodels/bubblesort.mo") 

true 

The function bubblesort is called below to sort the vecto x in descending order. The sorted result is returned 
together with its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is the 
declared type of the function result. The input Integer vector was automatically converted to a Real vector 
according to the Modelica type coercion rules. The function is automatically compiled when called if this has not been 
done before. 
>> bubblesort(x) 
{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0} 

Another call: 
>> bubblesort({4,6,2,5,8}) 
{8.0,6.0,5.0,4.0,2.0} 

It is also possible to give operating system commands via the system utility function. A command is provided as a 
string argument. The example below shows the system utility applied to the UNIX command cat, which here 
outputs the contents of the file bubblesort.mo to the output stream. However, the cat command does not boldface 
Modelica keywords – this improvement has been done by hand for readability. 
>> cd("C:/OpenModelica13/testmodels") 
>> system("cat bubblesort.mo") 

function bubblesort 
  input Real[:] x; 
  output Real[size(x,1)] y; 
protected 
  Real t; 
algorithm 
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  y := x; 
  for i in 1:size(x,1) loop 
    for j in 1:size(x,1) loop 
      if y[i] > y[j] then 
       t := y[i]; 
       y[i] := y[j]; 
       y[j] := t; 
      end if;  
    end for; 
  end for; 
end bubblesort; 

Note: Under Windows the output emitted into stdout by system commands is put into the winmosh console 
windows, not into the winmosh interaction windows. Thus the text emitted by the above cat command would not be 
returned. Only a success code (0 = success, 1 = failure) is returned to the winmosh window. For example:  
>> system("dir") 
0 

>> system("Non-existing command") 
1 

Another built-in command is cd, the change current directory command. The resulting current directory is returned as 
a string. 
>> cd() 
"C:\OpenModelica13\testmodels" 
 
>> cd("..") 
"C:\OpenModelica13" 
 
>> cd("C:\\OpenModelica13\\testmodels") 
"C:\OpenModelica13\testmodels" 

We load a model, here the whole Modelica standard library, which also can be done through the File->Load 
Modelica Library menu item: 
>> loadModel(Modelica) 
true 

We also load a file containing the dcmotor model: 
>> loadFile("C:/OpenModelica13/testmodels/dcmotor.mo") 
true 

It is simulated: 
>> simulate(dcmotor,startTime=0.0,stopTime=10.0) 

record 
    resultFile = "dcmotor_res.plt" 
end record 

We list the source  code of the model: 
>> list(dcmotor) 

"model dcmotor 
  Modelica.Electrical.Analog.Basic.Resistor r1(R=10); 
  Modelica.Electrical.Analog.Basic.Inductor i1; 
  Modelica.Electrical.Analog.Basic.EMF emf1; 
  Modelica.Mechanics.Rotational.Inertia load; 
  Modelica.Electrical.Analog.Basic.Ground g; 
  Modelica.Electrical.Analog.Sources.ConstantVoltage v; 
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equation  
  connect(v.p,r1.p); 
  connect(v.n,g.p); 
  connect(r1.n,i1.p); 
  connect(i1.n,emf1.p); 
  connect(emf1.n,g.p); 
  connect(emf1.flange_b,load.flange_a); 
end dcmotor; 
" 

We test code instantiation of the model to flat code: 
>> instantiateModel(dcmotor) 

"fclass dcmotor 
Real r1.v "Voltage drop between the two pins (= p.v - n.v)"; 
Real r1.i "Current flowing from pin p to pin n"; 
Real r1.p.v "Potential at the pin"; 
Real r1.p.i "Current flowing into the pin"; 
Real r1.n.v "Potential at the pin"; 
Real r1.n.i "Current flowing into the pin"; 
parameter Real r1.R = 10 "Resistance"; 
Real i1.v "Voltage drop between the two pins (= p.v - n.v)"; 
Real i1.i "Current flowing from pin p to pin n"; 
Real i1.p.v "Potential at the pin"; 
Real i1.p.i "Current flowing into the pin"; 
Real i1.n.v "Potential at the pin"; 
Real i1.n.i "Current flowing into the pin"; 
parameter Real i1.L = 1 "Inductance"; 
parameter Real emf1.k = 1 "Transformation coefficient"; 
Real emf1.v "Voltage drop between the two pins"; 
Real emf1.i "Current flowing from positive to negative pin"; 
Real emf1.w "Angular velocity of flange_b"; 
Real emf1.p.v "Potential at the pin"; 
Real emf1.p.i "Current flowing into the pin"; 
Real emf1.n.v "Potential at the pin"; 
Real emf1.n.i "Current flowing into the pin"; 
Real emf1.flange_b.phi "Absolute rotation angle of flange"; 
Real emf1.flange_b.tau "Cut torque in the flange"; 
Real load.phi "Absolute rotation angle of component (= flange_a.phi = flange_b.phi)"; 
Real load.flange_a.phi "Absolute rotation angle of flange"; 
Real load.flange_a.tau "Cut torque in the flange"; 
Real load.flange_b.phi "Absolute rotation angle of flange"; 
Real load.flange_b.tau "Cut torque in the flange"; 
parameter Real load.J = 1 "Moment of inertia"; 
Real load.w "Absolute angular velocity of component"; 
Real load.a "Absolute angular acceleration of component"; 
Real g.p.v "Potential at the pin"; 
Real g.p.i "Current flowing into the pin"; 
Real v.v "Voltage drop between the two pins (= p.v - n.v)"; 
Real v.i "Current flowing from pin p to pin n"; 
Real v.p.v "Potential at the pin"; 
Real v.p.i "Current flowing into the pin"; 
Real v.n.v "Potential at the pin"; 
Real v.n.i "Current flowing into the pin"; 
parameter Real v.V = 1 "Value of constant voltage"; 
equation 
  r1.R * r1.i = r1.v; 
  r1.v = r1.p.v - r1.n.v; 
  0.0 = r1.p.i + r1.n.i; 
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  r1.i = r1.p.i; 
  i1.L * der(i1.i) = i1.v; 
  i1.v = i1.p.v - i1.n.v; 
  0.0 = i1.p.i + i1.n.i; 
  i1.i = i1.p.i; 
  emf1.v = emf1.p.v - emf1.n.v; 
  0.0 = emf1.p.i + emf1.n.i; 
  emf1.i = emf1.p.i; 
  emf1.w = der(emf1.flange_b.phi); 
  emf1.k * emf1.w = emf1.v; 
  emf1.flange_b.tau = -(emf1.k * emf1.i); 
  load.w = der(load.phi); 
  load.a = der(load.w); 
  load.J * load.a = load.flange_a.tau + load.flange_b.tau; 
  load.flange_a.phi = load.phi; 
  load.flange_b.phi = load.phi; 
  g.p.v = 0.0; 
  v.v = v.V; 
  v.v = v.p.v - v.n.v; 
  0.0 = v.p.i + v.n.i; 
  v.i = v.p.i; 
  emf1.flange_b.tau + load.flange_a.tau = 0.0; 
  emf1.flange_b.phi = load.flange_a.phi; 
  emf1.n.i + v.n.i + g.p.i = 0.0; 
  emf1.n.v = v.n.v; 
  v.n.v = g.p.v; 
  i1.n.i + emf1.p.i = 0.0; 
  i1.n.v = emf1.p.v; 
  r1.n.i + i1.p.i = 0.0; 
  r1.n.v = i1.p.v; 
  v.p.i + r1.p.i = 0.0; 
  v.p.v = r1.p.v; 
  load.flange_b.tau = 0.0; 
end dcmotor; 
" 

We plot part of the simulated result: 
>> plot({load.w,load.phi}) 
true 
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We load and simulate the BouncingBall example containing when-equations and if-expressions (the Modelica key-
words have been bold-faced by hand for better readability): 
>> loadFile("C:/OpenModelica13/testmodels/BouncingBall.mo") 

true 

>> list(BouncingBall) 
"model BouncingBall 
  parameter Real e=0.7 "coefficient of restitution"; 
  parameter Real g=9.81 "gravity acceleration"; 
  Real h(start=1) "height of ball"; 
  Real v "velocity of ball"; 
  Boolean flying(start=true) "true, if ball is flying"; 
  Boolean impact; 
  Real v_new; 
equation  
  impact=h <= 0.0; 
  der(v)=if flying then -g else 0; 
  der(h)=v; 
  when {h <= 0.0 and v <= 0.0,impact} then 
    v_new=if edge(impact) then -e*pre(v) else 0; 
    flying=v_new > 0; 
    reinit(v, v_new); 
  end when; 
end BouncingBall; 
" 

Instead of just giving a simulate and plot command, we perform a runScript command on a .mos (Modelica 
script) file sim_BouncingBall.mos that contains these commands: 
loadFile("BouncingBall.mo"); 
simulate(BouncingBall, stopTime=3.0); 
plot({h,flying});  

The runScript command: 
>> runScript("sim_BouncingBall.mos") 
"true 
record 
    resultFile = "BouncingBall_res.plt" 
end record 
true 
true" 
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Clear all loaded libraries and models: 
 

>> clear() 
true 

List the loaded models – but nothing left: 
>> list() 
"" 

We load another model, the VanDerPol model (or via the menu File->Load Model): 
>> loadFile("C:/OpenModelica13/testmodels/VanDerPol.mo")) 
true 

It is simulated: 
>> simulate(VanDerPol) 
record 
    resultFile = "VanDerPol_res.plt" 
end record 

Assign a vector to a variable: 
>> a:=1:5 
{1,2,3,4,5} 

Type in a function: 
>> function MySqr input Real x; output Real y; algorithm y:=x*x; end MySqr; 
Ok 

Call the function: 
>> b:=MySqr(2) 
4.0 

Look at the value of variable a: 
>> a 
{1,2,3,4,5} 

Look at the type of a: 
>> typeOf(a) 
"Integer[]" 

Retrieve the type of b: 
>> typeOf(b) 
"Real" 
 

What is the type of MySqr? Cannot currently be handled. 
>> typeOf(MySqr) 
Error evaluating expr. 

List the available variables: 
>> listVariables() 
{currentSimulationResult, a, b} 

Do code instantiation to flat forrm of the VanDerPol model: 
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>> instantiateModel(VanDerPol) 

"fclass VanDerPol 
Real x(start=1.0); 
Real y(start=1.0); 
parameter Real lambda = 0.3; 
equation 
  der(x) = y; 
  der(y) = -x + lambda * (1.0 - x * x) * y; 
end VanDerPol; 
" 

Clear again: 
>> clear() 
true 

Leave and quit OpenModelica: 
>> quit() 
 

1.3 Commands for the Interactive Session Handler 
The following is the complete list of commands currently available in the interactive session hander. 

instantiateModel(modelname)Performs code instantiation of a model/class and return a string containing the flat 
class definition. 

simulate(modelname) Translate a model named modelname and simulate it. 
simulate(modelname[,startTime=<Real>][,stopTime=<Real>][,numberOfIntervals 

=<Integer>]) Translate and simulate a model, with optional start time, stop time, 
and optional number of simulation intervals or steps for which  the simulation 
results will be computed. Many steps will give higher time resolution, but occupy 
more space and take longer to compute. The default number of intervals is 500. 

plot(vars)  Plot the variables given as a vector or a scalar, e.g. plot({x1,x2}) or plot(x1). 
list()  Return a string containing all loaded class definitions. 
list(modelname)  Return a string containing the class definition of the named class. 
listVariables()  Return a vector of the names of the currently defined variables. 
typeOf(variable)  Return the type of the variable as a string. 
clear()  Clear all loaded definitions. 
clearVariables()  Clear all defined variables. 
timing(expr)  Evaluate expression expr and return the number of seconds (elapsed time) the 

evaluation took. 
cd()  Return the current directory. 
cd(dir)  Change directory to the directory given as string. 
system(str)  Execute str as a system(shell) command in the operating system; return integer 

success value. Output into stdout from a shell command is put into the console 
window. 

readFile(str)  Load file given as string str and return a string containing the file content. 
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runScript(str)  Execute script file with file name given as string argument str. 
loadModel(classname) Load model or package of name classname from MODELICAPATH. 
loadFile(str)  Load Modelica file (.mo) with name given as string argument str. 
saveModel(str,modelname) Save the model/class with name modelname in the file given by the string argument 

str. 
help() Print this helptext (returned as a string). 
quit() Leave and quit the OpenModelica environment 
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Chapter 2  
 
Getting Started with the Graphical Model Editor 

This chapter gives a short introduction to graphical modeling. You will learn how to build your own model using the 
graphical model editor by using the drag-and-drop technique of already developed and freely available components 
from the Modelica Standard Library. 

NOTE: This chapter is a preliminary description which in the near future will be replaced by a separate manual for 
the Graphical Model Editor. 

The Modelica Standard Library is loaded into the OpenModelica environment when the model editor is started and 
can be browsed using the class browser visible at the left of Figure 2-1 below. 

 
Figure 2-1.  The Graphical Model Editor with the class browser to the left, showing icons for the ModelicaAdditions 
library and the Modelica Standard library. 

To open the library, double click on the Modelica package icon in the class browser to the left. As shown by Figure 
2-2, the Modelica Standard Library is hierarchically structured into sublibraries. 
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Figure 2-2.  The Graphical Model Editor with the class browser showing the Modelica Standard library opened up into 
sublibraries. 

The following list briefly describes the most important sublibraries in the Modelica standard library: 

Thermal Components for thermal systems. 
Mechanics Mechanical rotational and translational components. 
Math  Definitions of common mathematical functions, such as sin, cos, and log. 
Electrical Common electrical components, such as resistors and transistors. 
Blocks  Continuous and discrete input/output blocks for use in block diagrams. 
SIunits Type definitions with SI standard names and units. 
Icons  Graphical layout for many component icons 
Constants Common constants from mathematics, physics, etc. 

2.1 Your First Model 
We will introduce the model editor by showing how to build a model of a simple DC motor. Since the DC motor 
includes both electrical and rotational mechanical components the example also illustrates multi-domain modeling. 



     21 

2.1.1 Creating a New Model 

To create a new model, select New Model in the File menu. A dialog box will appear, in which you will be able to 
specify a name of the new model. Enter Motor as Model name. 

  
Figure 2-3.  Dialog box for creating a new model. 

When clicking on the OK button of the dialog box a new window will appear. This window presents different views of 
the model. A model has two graphical views (Icon and Diagram), and one text view (ModelicaText). 

Your new Motor model will also appear at the top package level in the class browser. Since no icon for the model 
has yet been created it is assigned a default icon (a question mark).  
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Figure 2-4.  The Graphical Model Editor with the new Motor model appearing as a question mark icon in the class 
browser window to the left. 

Now you can assemble the DC motor by drag-and-drop of components from the class browser to the diagram view 
window to the right. The constant voltage source component can be found in the 
Modelica.Electrical.Analog.Sources package whereas the rotational mass representing the motor shaft is 
located in the Modelica.Mechanics.Rotational package. The other electrical components needed are located in 
the Modelica.Electrical.Analog.Basic package. 

Components placed in the diagram layer window can be graphically transformed using the mouse and keyboard. 
To move a component, select it and hold down the left mouse button while moving the mouse. The component will 
follow the mouse cursor. Release the mouse button when the component is located at the desired position. If more 
than one component is selected, all of them will be moved simultaneously. 

Scaling of components is done using the handles that are visible when a component is selected. Place the mouse 
cursor over one of the handles, click and hold down the left mouse button while moving the mouse. 

Components can also be rotated freely using the handles visible when a component is selected. Place the mouse 
cursor over one of the handles, click and hold down the left mouse button and the shift button on the keyboard while 
moving the mouse. The mouse cursor will change its appearance while rotating the component. 

Pressing the right mouse button when the mouse cursor is placed over a component brings up a menu with suitable 
operations. 
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Figure 2-5.  The Graphical Model Editor with several components dragged into the diagram view, and several 
sublibraries and model classes visible in the class browser window to the left. 

When the components have been placed on the drawing area, similar to the figure above, you have to draw the lines 
that connect the components. This is done using the connector tool from the toolbar: 

 
To connect two components, select the connector tool and place the mouse cursor over a connector, i.e., the square 
symbol on either side of the component. When you are close enough, the mouse cursor will change into a cross. Click 
and a hold down the left mouse button, drag the cursor to the other connector and then release the mouse button when 
the mouse cursor turns into a cross. Continue to connect all components until the model diagram resembles the one in 
Figure 2-6 below. 
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Figure 2-6.  The Graphic Model Editor with components connected into a simple DC motor model. 

2.1.2 Changing Parameter Values of Components 

To change a parameter value of a component, e.g. the resistance of the resistor, we need to switch to the Modelica 
Text View of the class. Click on the Modelica Text View button in the toolbar to switch to text mode: 

 
Whenever we switch from the graphical view to the Modelica Text View after making any changes to the model in 
the graphical layers we need to update the text view. Click on the Refresh Class button, also found in the toolbar: 

 
After the text view has been updated it should look similar to the one in Figure 2-7. The order of the component 
declarations and connection equations depend on in which order you placed them on the drawing area and connected 
them. 
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Figure 2-7.  The Graphical Model Editor with the Modelica Text View mode showing the new Motor model. This view 
also allows text editing of the model. 

 

Locate the line that starts with Modelica.Electrical.Analog.Basic.Resistor. Put the text cursor right after 
resistor1 and add the text (R=20). This text is a modification of the resistor component, changing its parameter R 
(resistance) from the default value of 1 to 20. The Modelica Text View should now look similar to the one found in 
Figure 2-8 below. 
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Figure 2-8.  The Modelica Text View of the Motor model, with a modifier R=20 added for the resistor1 component. 

When you make any changes to the model in the Modelica Text View you need to click on the Apply Class 
Definition button in the toolbar to confirm the changes: 

  
When you have done this, change class view back to the Diagram View and study the icon of the resistor component. 
It should show R=20 instead of R=1, i.e., the resistance of the resistor is now 20 ohm. 
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Figure 2-9.  The Diagram View showing R=20 for the resistor1 component. 

2.1.3 Translating and Simulating Using the Interactive View 

Translating and simulating is performed using the Interactive View of the simulation kernel window. To open the 
kernel window, select Open Kernel Window in the File menu. Enter the command simulate(Motor) in the 
interactive view to translate and simulate the model. 

 
Figure 2-10.  The interactive view of the simulation kernel window, with the simulation command 
simulate(Motor). 

2.1.4 Plotting 

After the model has been translated and simulated, any of its variables can be plotted using the plot command. 
Giving the command plot({inductor1.w, inertia1.a}) will bring up the window below. 

 
Figure 2-11.  OpenModelica plot window created by the command: plot({inductor1.w, inertia1.a}), after a 
simulation of the Motor model. 

2.1.5 Saving and Loading 

It is possible to save a model from the model editor. Saving a model will create a Modelica 2.0 standard output file 
with the extension .mo. This file can later be loaded back into the model editor. 



28                        

2.2 Keyboard Command Shortcuts 
The following are keyboard shortcut commands available in the different windows of the Graphical model editor, 
including the text editing window. 

2.2.1 Class Window – Common Shortcuts 

CTRL + O   Open a Modelica (.mo) file. 
CTRL + Q   Quit the model editor. 

2.2.2 Class Browser Window 

LEFT ARROW   Select the class to the left of the currently selected class. 
RIGHT ARROW   Select the class to the right of the currently selected class. 
UP ARROW   Select the class above the currently selected class. 
DOWN ARROW   Select the class below the currently selected class. 
ENTER  If the selected class is a package; open the package and view its contents, otherwise; open 

the class for editing. 
DELETE   Delete the selected class. 

2.2.3 Class Window – Graphical Layer View 

CTRL + S  Save class present in active class window. 
CTRL + Z   Undo last undo/redo supported operation. 
CTRL + Y   Redo last undo/redo supported operation. 
CTRL + A   Select all items. 
DELETE   Delete the selected items. 
CTRL + W    Zoom the view to fit the size of the window. 
F5    Switch to a full screen view of the graphical layer. 
ESC   Deselect all items, or if the Full Screen view is activated, return to normal view. 
SPACE    Pointer tool. 
C    Connector tool. 
L    Line tool. 
R    Rectangle tool. 
E    Ellipse tool. 
P    Polygon tool. 
T    Text tool. 
B    Bitmap tool. 
+    Zoom In tool. 
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-    Zoom Out tool. 
LEFT ARROW   Move selected items left, otherwise if no selection move view area left.  
RIGHT ARROW   Move selected items right, otherwise if no selection move view area right. 
UP ARROW   Move selected items up, otherwise if no selection move view area up. 
DOWN ARROW   Move selected items down, otherwise if no selection move view area down. 
CTRL + LEFT ARROW   Move view area to the left end of the diagram. 
CTRL + RIGHT ARROW   Move view area to the right end of the diagram. 
CTRL + UP ARROW   Move view area to the top of the diagram. 
CTRL + DOWN ARROW  Move view area to the bottom of the diagram. 
SHIFT + LEFT ARROW   Small move of selected items left; if no selection move view area left. 
SHIFT + RIGHT ARROW   Small move of selected items right; if no selection move view area right. 
SHIFT + UP ARROW   Small move of selected items up; if no selection move view area up. 
SHIFT + DOWN ARROW   Small move of selected items down; if no selection move view area down. 
PAGE UP   Move view area up. 
PAGE DOWN   Move view area down. 
SHIFT + PAGE UP  Move view area left. 
SHIFT + PAGE DOWN  Move view area right. 
HOME     Move view area to the upper left corner. 
END      Move view area to the lower left corner. 
CTRL + HOME    Move view area to the upper right corner. 
CTRL + END    Move view area to the lower right corner. 
CTRL + L   Rotate the selected items 90º to the left (anti-clockwise). 
CTRL + R   Rotate the selected items 90º to the right (clockwise). 
CTRL + H   Flip the selected items horizontally. 
CTRL + J   Flip the selected items vertically. 

2.2.4 Class Window – Modelica Text View 

CTRL + P  Print the text. 
CTRL + A   Select all text. 
CTRL + Z     Undo last edit. 
CTRL + Y     Redo last edit. 
CTRL + X   Cut the selected text to the Clipboard. 
CTRL + C   Copy the selected text to the Clipboard. 
CTRL + V   Paste Clipboard contents into the text editor. 
LEFT ARROW  Move one character left. 
RIGHT ARROW  Move one character right. 
UP ARROW  Move one line up. 
DOWN ARROW  Move one line down. 
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PAGE UP  Move one page up. 
PAGE DOWN  Move one page up. 
HOME   Move to the beginning of the line. 
END   Move to the end of the line. 
CTRL + HOME  Move to the beginning of the text. 
CTRL + END  Move to the end of the text. 
DELETE   Delete the selected text, or if no text is selected, delete the character to the right. 

2.2.5 Interative Kernel Window – Output View 

CTRL + C  Copy the selected text to the Clipboard. 
CTRL + A  Select all text. 

2.2.6 Interactive Kernel Window – Input Field 

CTRL + X  Cut the selected text to the Clipboard. 

CTRL + C  Copy the selected text to the Clipboard. 

CTRL + V  Paste Clipboard contents into the text field. 

CTRL + Z  Undo the last operation. 

CTRL + Y  Redo the last operation. 

DELETE   Delete the selected text, or if no text is selected, delete the character to the right. 

CTRL + A  Select all text. 

ENTER   Evaluate given command. 

UP ARROW  Step backward in the history of commands. 

DOWN ARROW  Step forward in the history of commands. 
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Chapter 3  
 
DrModelica Notebook and Model Editor 

This chapter covers the OpenModelica electronic notebook and model editor subsystem, together with the 
DrModelica tutoring system for teaching Modelica, which is based on such notebooks. 

However, the OpenModelica notebook facility is work in progress, which currently is only partially completed 
(see Section 0). For these reasons we first present the electronic notebook facility and DrModelica based on the 
MathModelica implementation. The OpenModelica electronic notebooks is a simplified version of those notebooks, 
that however still are able to handle the full DrModelica system. 

3.1   Interactive Notebooks with Literate Programming 
Interactive Electronic Notebooks are active documents that may contain technical computations and text, as well as 
graphics. Hence, these documents are suitable to be used for teaching and experimentation, simulation scripting, 
model documentation and storage, etc. 

The Notebook facility is actually an interactive WYSIWYG (What-You-See-Is-What-You-Get) realization of 
Literate Programming, a form of programming where programs are integrated with documentation in the same 
document. 
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Figure 3-1. Examples of notebooks in the MathModelica modeling and simulation environment. 

3.1.1   Tree Structured Hierarchical Document Representation 

Traditional documents, e.g. books and reports, essentially always have a hierarchical structure. They are divided into 
sections, subsections, paragraphs, etc. Both the document itself and its sections usually have headings as labels for 
easier navigation. This kind of structure is also reflected in electronic notebooks. Every notebook corresponds to one 
document (one file) and contains a tree structure of cells. A cell can have different kinds of contents, and can even 
contain other cells. The notebook hierarchy of cells thus reflects the hierarchy of sections and subsections in a 
traditional document such as a book. 
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package MyPackage 
  model class3 
  ... 
  end class3; 
  model class2 ... 
  model class1 ... 
  package MySubPackage 
    model class1 
      ... 
    end class1; 
  end MySubPackage; 
end MyPackage; 

 

(a) (b)  
Figure 3-2. The package MyPackage in a notebook (a) and as Modelica text (b). 

Modelica packages including documentation and test cases can also be stored as notebooks, e.g. as in Figure 3-1 or 
Figure 3-2. Those cells that contain Modelica model classes intended to be used from other models, e.g. library 
components or certain application models, can be marked as Modelica code cells. This means that it is possible to 
export the Modelica cells in the notebook MyPackage.nb of Figure 3-2a, into a file MyPackage.mo with the 
contents shown in  Figure 3-2b. 

3.2 The DrModelica Tutoring System 
Understanding programs is hard, especially code written by someone else. For educational purposes it is essential to 
be able to show the source code and to give an explanation of it at the same time.  

Moreover, it is important to show the result of the source code’s execution. In modeling and simulation it is also 
important to have the source code, the documentation about the source code, the execution results of the simulation 
model, and the documentation of the simulation results in the same document. The reason is that the problem solving 
process in computational simulation is an iterative process that often requires a modification of the original 
mathematical model and its software implementation after the interpretation and validation of the computed results 
corresponding to an initial model. 

Most of the environments associated with equation-based modeling languages focus more on providing efficient 
numerical algorithms rather than giving attention to the aspects that should facilitate the learning and teaching of the 
language. There is a need for an environment facilitating the learning and understanding of Modelica. These are the 
reasons for developing the DrModelica teaching material for Modelica and for teaching modeling and simulation.  
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Figure 3-3. The front-page notebook of the DrModelica tutoring system. 

DrModelica has a hierarchical structure represented as notebooks. The front-page notebook is similar to a table of 
contents that holds all other notebooks together by providing links to them. This particular notebook is the first page 
the user will see (Figure 3-3). 



     35 

In each chapter of DrModelica the user is presented a short summary of the corresponding chapter of the book 
“Principles of Object-Oriented Modeling and Simulation with Modelica 2.1” by Peter Fritzson. The summary 
introduces some keywords, being hyperlinks that will lead the user to other notebooks describing the keywords in 
detail.  

 
Figure 3-4. The HelloWorld class simulated and plotted using the MathModelica version of DrModelica. 

Now, let us consider that the link “HelloWorld” in DrModelica Section 2.1 in Error! Reference source not found. is 
clicked by the user. The new notebook, to which the user is being linked (see Figure 3-4), is not only a textual 
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description but also contains one or more examples explaining the specific keyword. In this class, HelloWorld, a 
differential equation is specified. 

No information in a notebook is fixed, which implies that the user can add, change, or remove anything in a 
notebook. Alternatively, the user can create an entirely new notebook in order to write his/her own programs or copy 
examples from other notebooks. This new notebook can be linked from existing notebooks. 

 
Figure 3-5. DrModelica Chapter 9 in the main page of the MathModelica version of DrModelica. 
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When a class has been successfully evaluated the user can simulate and plot the result, as depicted in Figure 3-4 for 
the simple HelloWorld example model.. 

After reading a chapter in DrModelica the user can immediately practice the newly acquired information by doing 
the exercises that concern the specific chapter. Exercises have been written in order to elucidate language constructs 
step by step based on the pedagogical assumption that a student learns better “using the strategy of learning by 
doing”. The exercises consist of either theoretical questions or practical programming assignments. All exercises 
provide answers in order to give the user immediate feedback.  

Figure 3-5 shows Chapter 9 of the DrModelica teaching material. Here the user can read about language 
constructs, like algorithm sections, when-statements, and reinit equations, and then practice these constructs by 
solving the exercises corresponding to the recently studied section. 

 

 
Figure 3-6. Exercise 1 in Chapter 9 of DrModelica. 

Exercise 1 in Section 9.1.1 is shown in Figure 3-6. In this exercise the user has the opportunity to practice different 
language constructs and then compare the solution to the answer for the exercise. Notice that the answer is not visible 
until the Answer section is expanded. The answer is shown in Figure 3-7. 
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Figure 3-7. The answer section to Exercise 1 in Chapter 9 of DrModelica. 
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3.3 Using OpenModelica Notebooks on DrModelica 
As mentioned in the introduction to this chapter, the OpenModelica notebook facility (OMNotebook) is 
a simplified implementation of the basic electronic notebook facilities, but advanced enough to represent 
hierarchical documents, simple type setting, text editing, etc., which is enough to be able to read in the 
whole DrModelica teaching material. 

 
Figure 3-8.  The start page (main page) of DrModelica in the OpenModelica notebook system. 

This is exemplified by Figure 3-8, showing the DrModelica main page (start page) in the teaching 
material. 

As can be seen from Figure 3-9 and Figure 3-10, the OpenModelica notebook implementation can 
already represent the hierarchical structure of documents, cells, etc., but lacks some polishing in terms of 
formatting and available commands. Also, no graphic information can currently be represented. 
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Figure 3-9.  The DrModelica main notebook in OpenModelica with most cells closed, only showing the 
title of each cell, thus creating a form of table-of-contents for the notebook. 

Figure 3-9 shows the main notebook of DrModelica will all cells closed, only showing the heading of 
each cell/section. This looks like a kind of table-of-contents, which is convenient for navigation in the 
notebook. To read a closed section, just click on it and it will open. 
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Figure 3-10.  The OpenModelica DrModelica notebook, showing the evaluation of a simple expression 
(5+7) in a cell in the middle, followed by the creation of an output cell to contain the result: 12.. 

The OpenModelica Notebook facility is coupled to the OpenModelica compiler and simulator, thus 
allowing evaluation of expressions, simulation of models, and interactive session commands as specified 
in Section 1.3. 

3.4 OpenModelica Notebook Commands 
The current prototype (2005-05-11) of OpenModelica notebooks support the following operations: 

• Opening and closing groups of cells by double clicking the hierarchical tree view (to the right). 
• Evaluation of Modelica code, commands, and expressions in input cells by typing 

SHIFT+RETURN. The evaluation results are shown in a created output cell. 
• Opening and loading notebook files stored in XML-format (Command: CTRL+O, Menu: File > 

Open). 
• Opening and loading notebook files stored in FullForm Mathematica notebook format 

(Command: CTRL+O, Menu: File > Open). 
• Saving notebook files in XML format (Command: CTRL+S, Menu: File > Open or File > Save 

As). 
• Close current document (Command: CTRL+W or ALT+F4, Menu: File > Close). 
• Terminating the notebook subsystem (Command: ALT+Q, Menu: File > Quit). 
• Select a cell, by a single click on the cell in the tree view to the right. 
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• Select more cells by a single click on the cell in the tree view to the right and holding CTRL 
pressed down. 

• Possibility to edit the style template to change the appearance of different cell types. This is done 
by editing the file stylesheet.xml. 

• Move cursor, by CTRL + UP ARROW or CTRL + DOWN ARROW, or Menu: Cell > Next Cell or Cell > 
Privous Cell. 

• Select and copy text inside a cell. 
• Color marking and indentation of Modelica code. 
• Show how text is stored inside a cell, by menu Edit -> View Expression. 
• Add a new cell (Command: CTRL+A, Menu: Cell > Add). 
• Create a input cell for openmodelica code (Command: CTRL+SHIFT+I, Menu: Format > Input 

cell). 
• Undo on text changes inside a cell (Command: CTRL+Z). 
• Create a group cell around the cell selected by the cursor (Command: CTRL+SHIFT+G, Menu: 

Format > Group cell). 
• Remove selected cell/cells (Command: CTRL+SHIFT+D, Menu: Cell > Delete). 
• Cut selected cell/cells (Command: CTRL+SHIFT+X, Menu: Cell > Cut Cell). 
• Copy selected cell/cells (Command: CTRL+SHIFT+C, Menu: Cell > Copy Cell). 
• Paste cut or copyed cell/cells (Command: CTRL+SHIFT+V, Menu: Cell > Paste Cell). 
• Change text style for a cell, with menu Format -> Styles -> (select style). 
• Clickable active links that opens the linked document when clicked on the link. Links can only 

be opend if the cell containing the link is not selected. 

The following functionality is ongoing work and is currently being implemented: 

• Add own links to the text. 
• Moving a cell by dragging it in the tree view. 
• Pasting graphic images into special graphic cells. 
• Display ploted images in special graphic cells. 
• Change text settings on individual words and letters. 
• Export document text to pure text form with no structure saved. 
• Undo/Redo for cell changes. 
• Search and replace functions. 
• Print function. 
• Change between different stylesheets at runtime. 
• Change syntax highlighting colors at runtime. 
• Magnification on the document. 
• Convert the cell type from one type to another type. 
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Chapter 4  
 
Emacs Textual Model Editor/Browser 

The Emacs Modelica mode provides facilities for keyword highlighting, suppressing annotations, etc. 

(?? Need to describe those facilities, including how the Modelica mode is started). 

Another quite useful facility is the Speedbar menu, depicted in Figure 4-1. (?? This Screendump shows 
the same facility used for RML code, not Modelica code. Needs to be updated) 

 

 
Figure 4-1.  Emacs with a speedbar menu to the left, which allows clicking on file names (for expansion 
or closing the file contents menu). An expanded file shows all function, class, and type declarations. By 
clicking on one of those, you can position the editor at the appropriate definition. 

Give the command M-x speedbar to start the Speedbar menu. See Section 6.1 for an explanation to the 
notation M-x, etc. 

When you open files the speedbar menu will automatically update itself. You can double-click with 
the left mouse button or single-click with the middle button to expand trees, and jump between files and 
program definitions. 
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At the top you see the search path to the current directory, where you can click on the directory 
names at different levels to jump back and forth in the hierarchy. Subdirectories are visible in the tree as 
expandable nodes. 

It is also possible to right-click in the speedbar window to have a menu appear. 
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Chapter 5  
 
 
Eclipse Plugin Model Editor/Browser 

The Eclipse plugin is currently in a prototype stage. The following functionality is available, but need to 
be slightly improved before the first release: 

• A Modelica package browser is available for browsing packages and classes. 
• Integration with the Eclipse text editor is available. 
• The Eclipse editor works well and has been extended with Modelica syntax highlighting and 

automatic indentation. 
• The basic platform functionality is available but need to be improved. 
• The compilation support is fully functioning. 
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Chapter 6  
 
Modelica Algorithmic Subset Debugger 

This chapter presents a comprehensive Modelica debugger for an extended algorithmic subset of the 
Modelica language. This replaces debugging of algorithmic code using primitive means such as print 
statements or asserts which is complex, time-consuming and error- prone.  

The debugger is portable since it is based on transparent source code instrumentation techniques that 
are independent of the implementation platform. 

The usual debugging functionality found in debuggers for procedural or traditional object-oriented 
languages is supported, such as setting and removing breakpoints, single-stepping, inspecting variables, 
back-trace of stack contents, tracing, etc.  

We presents the debugger functionality by a debugging session on a short Modelica example. The 
functionality of the debugger is shown using pictures from the Emacs debugging mode for Modelica 
(modelicadebug-mode).  

Note 1: The current (March 2005) implementation of the debugger only works together with the 
Modelica compiler version that supports an extended algorithmic subset of Modelica, without equations 
and simulation, but including meta-programming support. Both compiler versions will be merged into a 
single version in the near future. 

Note 2: when applying the debugger to debug the OpenModelica compiler itself, give the make 
debug command to compile the code with debugging turned on, or just the command: make, to compile 
it without debugging support. 

6.1 The Debugger Commands 
The Emacs Modelica debug mode is implemented as a specialization of the Grand Unified Debugger 
(GUD) interface (gud-mode) from Emacs. Because the Modelica debug mode is based on the GUD 
interface, some of the commands have the same familiar key bindings.  

The actual commands sent to the debugger are also presented together with GUD commands 
preceded by the Modelica debugger prompt: mdb@>.  

If the debugger commands have several alternatives these are presented using the notation: 
alternative1|alternative2|....   

The optional command components are presented using notation: [optional]. 
In the Emacs interface: M-x stands for holding down the Meta key (mapped to Alt in general) and 

pressing the key after the dash, here x,  C-x stands for holding down the Control (Ctrl) key and 
pressing x, <RET> is equivalent to pressing the Enter key, and <SPC> to pressing the Space key. 

6.2 Starting the Modelica Debugging Subprocess 
The command for starting the Modelica debugger under Emacs is the following: 
M-x modelicadebug <RET> executable <RET> 
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6.3 Setting/Deleting Breakpoints 
A part of a session using this type of commands is shown in Figure 6-1 below. The presentation of the 
commands follows. 

 
Figure 6-1.  Using breakpoints. 

To set a breakpoint on the line the cursor (point) is at: 
C-x <SPC> 
mdb@> break on file:lineno|string <RET> 

To delete a breakpoint placed on the current source code line (gud-remove): 
C-c C-d  
C-x C-a C-d 
mdb@> break off file:lineno|string <RET> 

Instead of writing break one can use alternatives br|break|breakpoint. 
Alternatively one can delete all breakpoints using: 

mdb@> cl|clear <RET> 

Showing all breakpoints: 
mdb@> sh|show <RET> 

6.4 Stepping and Running 
To perform one step (gud-step) in the Modelica code: 
C-c C-s  
C-x C-a C-s 
mdb@> st|step <RET> 

To continue after a step or a breakpoint (gud-cont) in the Modelica code: 
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C-c C-r  
C-x C-a C-r 
mdb@> ru|run <RET>  

Examples of using these commands are presented in Figure 6-2. 

 
Figure 6-2.  Stepping and running. 

6.5 Examining Data 
There are no GUD keybindings for these commands but they are inspired from the GNU Project 
debugger (GDB).  

To print the contents/size of a variable one can write: 
mdb@> pr|print variable_name <RET> 
mdb@> sz|sizeof variable_name <RET> 

at the debugger prompt. The size is displayed in bytes. 
Variable values to be printed can be of a complex type and very large. One can restrict the depth of 

printing using: 
mdb@> [set] de|depth integer <RET> 

Moreover, we have implemented an external viewer written in Java called ModelicaDataViewer to 
browse the contents of such a large variable. To send the contents of a variable to the external viewer for 
inspection one can use the command: 
mdb@> bw|browse|gr|graph var_name <RET> 



50                        

at the debugger prompt. The debugger will try to connect to the ModelicaDataViewer and send the 
contents of the variable. The external data browser has to be started a priori. If the debugger cannot 
connect to the external viewer within a specified timeout a warning message will be displayed. A picture 
of the external ModelicaDataViewer tool is presented in Figure 6-3. 

 
Figure 6-3.  Modelica Data Viewer (Browser) for data structures, here a small abstract syntax tree. 

If the variable which one tries to print does not exist in the current scope (not a live variable) a notifying 
warning message will be displayed. 

Automatic printing of variables at every step or breakpoint can be specified by adding a variable to a 
display list: 
mdb@> di|display variable_name <RET> 

To print the entire display list: 
mdb@> di|display <RET> 

Removing a display variable from the display list: 
mdb@> un|undisplay variable_name <RET> 

Removing all variables from the display list: 
mdb@> undisplay <RET> 

Printing the current live variables: 
mdb@> li|live|livevars <RET> 

Instructing the debugger to print or to disable the print of the live variable names at each step/breapoint: 
mdb@> [set] li|live|livevars [on|off]<RET> 

Figure 6-4 shows examples of some of these commands within a debugging session: 
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Figure 6-4.  Examining variable values using print and display commands. 

6.6 Additional commands  
The stack contents (backtrace) can be displayed using: 
mdb@> bt|backtrace <RET> 

Because the contents of the stack can be quite large, one can print a filtered view of it: 
mdb@> fbt|fbacktrace filter_string <RET> 

Also, one can restrict the numbers of entries the debugger is storing using: 
mdb@> maxbt|maxbacktrace integer <RET> 

For displaying the status of the Modelica runtime: 
mdb@> sts|stat|status <RET> 

The status of the extended Modelica runtime comprises information regarding the garbage collector, 
allocated memory, stack usage, etc. 

The current debugging settings can be displayed using: 
mdb@> stg|settings <RET> 

The settings printed are: the maximum remembered backtrace entries, the depth of variable printing, the 
current breakpoints, the live variables, the list of the display variables and the status of the runtime 
system. 

One can invoke the debugging help by issuing: 
mdb@> he|help <RET> 

For leaving the debugger one can use the command: 
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mdb@> qu|quit|ex|exit|by|bye <RET> 

A session using these commands is presented in Figure 6-5 below: 

 
Figure 6-5.  Additional debugger commands. 

6.7 Hints for Debugging Large Programs 
In order to faster get to an interesting place when debugging a large program such as the OpenModelica 
compiler itself, you can put a breakpoint at the place where you would like to start the investigation, but 
give the fast debug command when starting the execution from the beginning. In that case the 
debugger will avoid saving backtrace and variables up to this breakpoint. Then you can turn off 
backtrace and run the debugger as usual. 

6.8 Summary of Debugger Commands 
The following is a complete list of the current debugger commands 

br|break|breakpoint string [on|off] Setting/unsetting breakpoints      
cl|clear   Clear all breakpoints 
sh|show   Show all breakpoints 
bt|backtrace   Print the backtrace (stack) 
fbt|fbacktrace filter   Print filtered backtrace (stack) 
mb|maxbacktrace int (0=full, default=0) Set the maximum of backtrace entries (stack). 
ca|callchain   Print the call chain 
fca|fcallchain filter   Print filtered call chain 
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mc|maxcallchain integer   Set the maximum of callchain entries. (0=full, default=100) 
 
[set] de|depth integer   Set the depth of variable printing. (0=full, default=10) 
[set] ms|maxstring integer Set how may chars we print from long strings. (0=full, 

default=60) 
set st|step [on|off]  Set the execution mode. 
st|step|<ENTER>|<CR>  Perform one step.  
ne|next   Jump over next statement. 
ru|run   Run the program. 
stg|settings   Print the current settings. 
he|help   Showing help. 
sts|stat|status   Printing the status of Modelica runtime. 
li|live|livevars   Print the names of live variables. 
[set] li|live|livevars [on|off] On/Off printing names of livevars each step. 
pr|print var_name   Print the live variable. 
sz|size|sizeof var_name   Print sizeof the live variable. 
di|display var_name   Display the live variable each step. 
ud|undisplay var_name   Un-display the live variable. 
di|display   Show display variables. 
ud|undisplay   Un-display ALL display variables. 
gr|graph var_name   Send the live variable to external viewer. 
pty|printtype identifier   Print type info on any Modelica id. 
fa|fast   FAST debugging: no backtrace, callchain, livevars. 
qu|quit|ex|exit|by|bye   Exiting the debugger/program. 
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